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Copyright ©1996 by PelicanWare, Inc.

AvailWorks For Newton, Avail ClipArt For Newton
and Avail NotepadPlus For Newton are trademarks of PelicanWare, Inc.
Newton, Macintosh and Apple are trademarks of Apple Computer, Inc.

Windows is a trademark of Microsoft Corp.
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Technical Support

This AvailWorks User’s Manual contains detailed information and important tips on using the software. If you
do not find the answer to your question in this manual, you should visit our World Wide Web site at
http://www.pelicanware.com/. Updated support information and answers to frequently asked questions will be
posted there. Support questions may also be addressed to any of the following:

Compuserve: 74774,1317
Internet: support@pelicanware.com
Fax: (503) 221-8709

Additional information is available in the PelicanWare section of the Newton Vendor Forum on CompuServe
(GO NEWTVEN). You may also call our Technical Support Department at (503) 221-1148. Technical support is
available Monday to Friday from 9:00 AM to 5:00 PM Pacific time.

Comments and Suggestions

We welcome your comments and suggestions regarding AvailWorks. Please send via email or address them to:
PelicanWare, Inc.
550 S.W. Park Avenue, Suite 270
Portland, OR  97205
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3Introduction and Installation

SE C T I O N 1

Introduction and Installation

Welcome to Av a i l Works For Newton™
AvailWorks gives you four easy-to-use applications integrated into one package. It includes powerful page lay-
out tools that enable you to quickly create full page documents on your Newton for faxing, printing, beaming or
mailing. AvailWorks includes tools for creating and editing text, labels, drawings, tables and graphs.

• Label - allows you to enter and edit blocks of text with full control over text font, size, style, frame, tabs
and word-wrapping. You can also to create text “macros” that can instantly insert often-used phrases that
you define. 

• Draw - provides a complete set of drawing tools for creating lines, rectangles, round-rectangles, ovals,
curves, polygons, and special pre-defined shapes. The ClipArt capability of AvailWorks allows you to save
images that you create in AvailWorks for later reuse, or to use images from the variety of separately-sold
Avail ClipArt For Newton libraries.  

• Tables - includes the ability to quickly create spreadsheets at any page location using powerful built-in
formulas, functions and presentation formatting. Data values can also be imported/exported to and from
desktop Macintosh and Windows computers.

• Graphs - offers the most popular business graph formats including line, bar, and pie graphs which you
customize with a wide range of display options. Graphs can also be linked to spreadsheets for "live" graph
updates whenever the data is changed.

I n s t a l l a t i o n
AvailWorks (AvailWorks.pkg) is installed using the supplied Macintosh Newton Package Installer or Windows
NEWTINST.EXE or your Newton Backup Utility.You must have at least 350K of free internal or PCMCIAstorage
card space.

If updating, first remove any previous version of AvailWorks or TapWorks. Note that AvailWorks is stored in
compressed format on your Newton, and although the listed uncompressed size is 597+ bytes, the actual space
required to store the program on your Newton is just under 350K. 

After any software installation is complete, it is always best to reset your Newton as follows:
• Turn the Newton over so that the screen is facing down. Be sure to do this

on a surface that won’t damage the screen. 
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4 Introduction and Installation

• Slide off the battery compartment cover.
• Using the stylus, tap the Reset button (Note that this does NOT erase any

of your data).
• Replace the battery compartment cover and turn the Newton back over.
• Once the restart procedure is complete, open the Extras drawer and tap on

the AvailWorks icon to launch the program.
AvailWorks 2.0 requires Newton Operating System version 2.0, or later.

R e g i s t r a t i o n
Please take a few moments to fill-in your registration card. By registering, you are entitled to free technical sup-
port and are kept informed of any program updates, special promotions and new software.
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5AvailWorks Overview and Menus

SE C T I O N 2

Av a i l Works Overview and Menus
AvailWorks allows for the development of a full size page (8 1/2 by 11 inch, A4, etc.) containing text, drawn
objects, label boxes, spreadsheets and graphs. No matter what the size of your Newton screen is, you can layout,
print, beam, mail and fax a full size page.  

D r a w, Label, Table and Graph
The four modes in AvailWorks are Draw, Label,
Table and Graph. This illustration at left shows a full
size page, incorporating features from all four
modes plus a ClipArt image.

When the Draw mode is active, you have tools
for drawing various shapes and lines. There ar e
options to change the line width, pattern and fill of
objects.  You can also create your own ClipArt
images or use images from any of the separately-
sold Avail ClipArt For Newton™ libraries.

The Label mode is used for creating and editing
text boxes. All of the text entered onto a page is
entered into text boxes. Each text box contains its
own formatting such as font, size, style and frame.
Text boxes can be moved and resized anywhere on
your page layout. 

Table mode allows the creation of spreadsheets
that contain text, math calculations and any of the
over 100 built-in functions. Formatting of cells
includes alignment, text styles, column width, and
various number formats to display decimals, dollars
and percents. Spreadsheets can also be moved and
resized anywhere on the page. 

Graph contains seven types of charts and graphs.
Options allow you to specify the data ranges, the
number of divisions, two series of numbers as well
as the pattern for lines and bars. Graphs are easily
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6 AvailWorks Overview and Menus

resized and moved anywhere on the page.  Graphs may also be linked to any table for automatic graph updates
when a table’s data is changed.

Av a i l Works Main Screen
This section gives you a brief overview of the tools and features found on the main screen of AvailWorks. There
are two fully editable views available. Either view can be used to create, edit, select and arrange objects on the
page.  All object editing features are fully functional in either mode.  The "Fit To Screen" view is best suited for
overall layout tasks such as general placement and sizing of objects on the page, while the "Actual Size" view is
useful for fine editing and precise arrangement of objects, and for entering handwritten or typed text.

A preview of the entire page (including all objects and text) can also be viewed at any time by using the Print
dialog’s preview option. (For a complete discussion, see the File Management Section).

The scroll bars allow you to move to other parts of the page while in the “Actual Size” view. The scroll bars
are described in further detail later on in this section.

Scrolling "Actual Size" View Full Page "Fit To Screen" View
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7AvailWorks Overview and Menus

The Tool Bar Menu options
Status area
Tool options

The Tool Bar is fixed at the top of the screen, just below the row of menu options, and does not overlap the page
display area. The tool bar contains two sections: the status area at the top, and the the tool option buttons at the
bottom. 

The status areadisplays the name of the tool and, when appropriate, brief instructions for using the tool or
other helpful messages.

From the tool bar you switch between the four main program modes. Tap on the mode selectorbutton and
select Label, Draw, Table or Graph. The tool option buttons change as you change modes.

At the bottom of the screen are pop-up options> for drawing pen width, pen patterns , fill patterns.

Using the To o l s
As you change modes, different tools become available for use. In the label mode, the attributes, such as font,
size, style and frame are set before or after the creation of the text box. In order to change the text style in an
existing box, the box has to first be selected. 

Selecting Objects
Tap the pen once on an object to be selected. A selection box appears around the selected objects. A group of
objects is selected by tapping once on each of the objects.

When Front Selections Only is activated on the Select
menu, only the top most item in a group is selected. (For
further information, see the discussions in this chapter on
the Front Selections Only and Rear Selections Only options
under the Select menu.)

Selected object and text.      Just front text box selected.

Moving Objects on the Page
First select the object or objects to be moved using the selection process described above. Place the pen inside the
selection box that surrounds the objects. Holding the pen to the screen, drag in the desired direction. When you
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8 AvailWorks Overview and Menus

have moved the object to the desired location, lift the pen and the object is placed in the new position. Tap Undo
to return the object to its former location.

C e n t e r i n g on the Page
The "Actual Size" view features horizontal and vertical scroll barsalong the right and bottom of the page display
area.  These function very similarly to scroll bars used on desktop
computers, and can be used to quickly scroll the page display to
view any desired location.  The relative position of the page is also
easy to determine based on the position of the two scrollers.  For
example, the screen shown in the example at right indicates the
page is centered on the screen.

Resizing Objects
First select the object or objects to be resized. Tap on the selection
border and hold the pen down. Drag the selection box to resize and
release the pen. If Constrain is checked, the object retains its original
proportions.

D e l e t e
Drawn objects, text boxes, spreadsheets and graphs are all erased by
“scrubbing” them out. Draw a zigzag mark with at least four lines
(a “W” shape works nicely) across the object or objects to be delet-
ed, covering at least half of the object. The Undo key will restore an
object that has been scrubbed out.

The entire page is deleted by tapping on the Action button
(envelope icon) at the bottom right of the screen. Select Delete from
this menu. The trash can appears and the entire page is thrown
away.

U n d o
The Newton Undo button can be used to undo many recent actions. Tap the key once to undo the last
change, or twice to undo the last two changes. 

Scroll bars Indicating Page Position

AvailWorks Manl  8/6/96 4:01 PM  Page 8



9AvailWorks Overview and Menus

The AvailWorks Menus
The File Menu 
The File Menu offers several options for working with pages created
in AvailWorks.  The New Page  option allows you to create a new
blank page. The new page is saved within the file that is currently
displayed on the folder tab at the top of the screen. 

The Page Setup dialog allows you to specify the number of pages in
the current document, and to decide if the underlying text layer
should have dotted guide lines or not.

The "Open…," "Rename…" and "Delete…" options all produce a dialog
containing a list of all AvailWorks pages in the current folder, as well as
the Folder Tab for navigating between folders.  The "Open…" option also
offers a second option to "Open as Untitled."  This allows an existing page
to be opened as a template for further modifications, while leaving the
original page unchanged.

Note that the "Open…" dialog can also be accessed by tapping the
"Overview" dot between the up and down arrows on the Newton.  Also
note that large lists can be scrolled using the up and down arrows on the
Newton.

There are also options for copying the information on the page to the Notepad, and importing/exporting to and
from the page. (For a more complete discussion, see the information contained in the File Management Section).

The Edit Menu
The Edit Menu contains the basic object editing commands as well as the
options for working with ClipArt, text macros, checking spelling in the text
layer, etc..

Cut Object. This removes any selected object or group of objects from the
page. They may be replaced by selecting Undo or Paste. Undo places the object
back in its original position while Paste places it in the center of the current
screen view.

File Open Dialog
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10 AvailWorks Overview and Menus

Copy Object. This command is used to create an exact duplicate of the selected items. Select Paste  Object to
place the copy onto the page. Multiple copies of the same item are created by selecting Paste  Object repeatedly.

Paste Object. This is used in conjunction with the Copy Object  and Cut  Object commands. It allows you to repo-
sition items or create multiple copies of an object.

Clear Object. This removes the selected items from the page. They may be restored using the Undo feature.

The ClipArt capability of AvailWorks allows you to save images that you create in AvailWorks for later reuse, or
to use images from any of the variety of the separately sold ClipArt Libraries.  Complete details on installing
additional ClipArt libraries for use in AvailWorks are provided in the Using ClipArt Libraries Section.

Copy To ClipArt. Using the "Copy To ClipArt" option, a picture of any selected images on your AvailWorks page
is copied into the Installed ClipArt library on your Newton.  You may copy text, drawings, spreadsheets and
graphs into the Installed ClipArt with this command.  Note that a table or graph copied to ClipArt only saves a
"picture" of the object, without any of the original data, and is pasted back onto a page as a static image that can-
not be edited.

Paste From ClipArt. Selecting "Paste From ClipArt…" produces a ClipArt browserdialog, where you may
choose from the Installed ClipArt images. The scroll bar below the displayed image can be used to scroll forward
or backward through the ClipArt images.  The built-in Newton up- and down-arrows may also be used to scroll
through the images, if desired.

The pop-up selections at the upper-right of the displayed image allow you to control whether the image is dis-
played at full-size (100%) or at a reduced-size, if necessary, to fit the display area.  If the image is displayed at a
reduced-size, then the percentage of its full size is displayed at the above-right of the image.

Once the desired image is located, tapping the "Paste" button will paste the image onto the AvailWorks page, and
close the ClipArt browser.  ClipArt images pasted onto a page in AvailWorks can then be moved or resized like
any other object on the page.

Images may also be removed from the Installed ClipArt library by tapping the "Clear" button in the ClipArt
browser.  Note that tapping the "Undo" icon after clearing an image will restore it to the end of the Installed
ClipArt images.
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11AvailWorks Overview and Menus

Create Text Macro. This option allows you to save frequently used text phrases for repeated use. For a complete
discussion refer to the Entering Labels Section of this manual.

Paste From Text Macro. This option allows you to paste from any of the previously saved text phrases. Again,
for a complete discussion refer to the Entering Labels Section of this manual.

Edit Selected Object. Choosing this option opens the editor for a selected label, graph or table object.

Check Spelling. This option checks the spelling of words in the text
layer, starting at the current text insertion caret. For each word that is
not found in the specified dictionaries (see the next section on Spelling
Options), the spelling corrector dialog appears. This dialog displays the
misspelled word for correcting. Change any desired characters, and

Select paste from the
ClipArt browser…

…to paste image
at the center of page.
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12 AvailWorks Overview and Menus

then tap the “Change” button to replace the originally misspelled text with the corrected text. You may also
choose to ignore this occurrence of the misspelled word, or to ignore all occurrences. Finally, you may tap “Add”
to add the displayed text to your user dictionary.

Check Spelling From Top. This options is the same as the previous option, except that it begins checking the
spelling from the top of the document, regardless of where the current text insertion caret is displayed.

Spelling Options. The Spelling Options dialog allows you to specify
which of the Newton’s built-in dictionaries to use when checking the
spelling in a document.
Note: For the spell-check options to work correctly for text entered in the
“universal” text recognition mode, first uncheck the “User-added words”
dictionary.

Find. This option allows you to enter text, and then tap the “Find” button to
move to the next occurrence of the text. After an occurrence is located, a “Find
Next” option appears allowing you to
move to the next occurrence.

Replace. This option allows you to enter
text, and then tap the “Replace” button to

move to the next occurrence of the text. After an occurrence is located, “Find
Next” and “Replace”options appear allowing you to replace and move to
the next occurrence, or to just move to the next occurrence.

Tapping “Replace All” replaces all text layer occurrences. Tapping
“Undo” restores all occurrence to the original text after a “Replace All.”

The Select Menu 
The Select Menu includes options to simplify selecting and deselecting
objects on the page.

Select All. This selects all the objects on the page. 

Select None. This de-selects all the objects on the page. 
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13AvailWorks Overview and Menus

Front Selections Only. When this option is activated, only the top most object within the selection marquee gets
selected. Suppose, for example, that you drew an oval, placed a text box within it. Subsequently you decided to
change the location of the text. 

In order to select just the text box and not the oval, activate the Front Selection Only option before selecting it.
This allows for just the text box to be highlighted and moved.

Rear Selections Only. When this option is activated, only the bottom most object within the selection marquee
gets selected. 

Auto-Select New Objects. When this option is in effect, all new objects are automatically selected immediately
after you draw them. New objects can have changes such as pattern fill and line widths applied immediately.
This feature is disabled by selecting it from the Select menu.

Keep Tool. The Keep Tool option locks in a tool for repeated use. This is helpful when you need to create several
objects using the same tool. For example, selecting the Keep Tool option before using the rectangle drawing tool
lets you continue to draw rectangles until you select a different tool.  It is also useful for drawing repeated
strokes when using the “Curve” drawing tool for sketching (you may also want to uncheck the Select Menu’s
“Autoselect New Objects” option in this case, too).

Constrain. Constrainacts upon the tool in use to restrict its shape. If constrain is checked, perfect squares are
drawn with the rectangle tool and circles with the oval tool. All the shapes in the palette retain their proportions.
When using the straight line tool, the constrain option only lets you draw lines that are horizontal, vertical or at
45° angles.

Constrain also acts on objects as they are resized. The object maintains its proportions as the size is increased or
decreased. Without Constrain activated, it is possible to drag a square into a rectangle and a circle into an oval.
With Constrain active, the square remains a square and the circle, a circle. Constrain also applies to label boxes as
well as graphs and charts.
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The Arrange Menu 
The arrange menu contains the commands for manipulating the
objects on the page. These options allow you to move objects forward
or backward in the drawing order. Nudge and Align also allow you to
move objects and align several objects.

Change Object Drawing Order. The first four items move text
boxes, drawing objects, graphs and tables to the front or back as well as incrementally in front of or behind the
next object. 

First select the object to be moved. To place it behind all the other objects, select Send to Back. If the object is
behind others, select it and choose Move to Front to bring it to the top.

Move Backward and Move Forward move the selected object up one level within the drawing order. The draw-
ing order applies to all the objects on the screen. If an object does not appear to have moved forward or back-
ward within the group you are working, keep selecting the option you want until it does. The object is simply
moving through the hierarchy of all objects on the page.

Align. This tool gives you six options for aligning selected objects to each other. The icons with-
in the align tool illustrate how the objects will align. The top row controls horizontal alignment
and the bottom row controls vertical alignment.

First select the objects to be aligned. Tap on desired alignment option. The objects align to
the object in the farthest position. For example, if you were to align several objects based on the
left border, the objects align to the one that is farthest to the left. 

Alignment is always based on the bounding rectangle of the object even if the border is not
displayed. Aligning text boxes based on the left border may not appear to align properly if the text within the
box is not left justified.

The Align tool may be moved to another location on the screen by placing the pen on the title bar and drag-
ging it. The tool is removed from your screen by tapping the close box in the lower right corner.

Nudge. This tool is used for moving objects one pixel at a time. Select an object or group of
objects. Tap on a directional arrow within the Nudge tool. The object moves one pixel in that direc-
tion. Holding the pen down on one of the arrows continues the movement of the object until the
pen is released.

The Nudge tool may be moved to another location on the screen by placing the pen on the title
bar and dragging it. The tool is removed from your screen by tapping the close box in the lower
right corner.
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15Working with the Drawing Tools

The View Menu 
The View Menu allows switching between the two basic page view
modes in AvailWorks: the scrolling “Actual Size” view or the reduced
“Fit To Screen” view. Note that the text layer is not visible in the “Fit
To Screen” view. Use the Action Menu “Print Page” option to preview
the full page including the text layer.

Filing Button
The Filing Buttonbrings up the standard dialog for assigning a folder designation to the currently displayed
page. The list of folders you currently have is displayed. Tap the appropriate button for the folder you want and
tap File. To create a new folder or to edit the name of an existing one, tap the Edit Folders button. (For a more
complete discussion, see the information contained in the File Management Section).

The Action Button
The A c t i o n button(the envelope icon) contains the options for print-
ing, mailing, faxing and beaming. You also have options for moving
pages to and from cards, and deleting a page.  And finally, the
"Duplicate" option makes a new "Untitled" copy of the currently dis-
played page. (For a more complete discussion, see the information
contained in the File Management Section).

SE C T I O N 3

Working with the Drawing To o l s
Tap on the mode selector and choose Draw. The tool bar displays a
palette of drawing tools. 

Drawing To o l s
Straight Line. Tap on the Straight Line toolto select it. Place the pen on the page and drag a line in the
desired direction. To constrain the line to horizontal, vertical or 45° angles, check the Constrain menu
option before selecting the straight line tool.
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16 Working with the Drawing Tools

Rectangle. Tap on the Rectangle toolto select it. Place the pen on the page and drag a rectangle of the
desired size and shape. To constrain the shape to a square, check the Constrain menu option before
selecting the rectangle tool.
Rounded Rectangle. Tap on the Rounded Rectangle toolto select it. Place the pen on the page and drag
a rectangle of the desired size and shape. To constrain the shape to a square with rounded corners,
check the Constrain menu option before selecting the rounded rectangle tool.
Curve. Tap on the Curve toolto select it. Place the pen on the page and draw a line. The curve ends
when the pen is raised from the screen. To “sketch” a series of strokes using the Curve tool (writing a
signature, for example), it is best to first select Keep Tool under the Edit menu and uncheck Auto-Select
New Objects under the Select menu.
Oval. Tap on the Oval toolto select it. Place the pen on the screen and drag a circle or oval of the
desired size and shape. To constrain the shape to a circle, check the Constrain menu option before select-
ing the circle tool.
Polygon. Tap on the Polygon toolto select it. Tap the page to set the first corner point. Tap again to set
the next point. Repeat until the polygon is the desired size and shape. Double tap on the page, or tap
once on the polygon tool button again to complete the polygon.
Shapes Palette. Tap once on the Shapes toolto pop-up the shape selection palette.

Tap on the desired shape in the palette. Place the pen on the screen and drag the
shape to the desired size. To “flip” the shape, drag it in a different direction. For
example, to create an arrow that points left, select the shape and drag from right to
left. The newly selected shape now remains as the default for the tool.

To constrain the shape symmetrically, check the Constrain menu option before
selecting a tool.

L i n e s and P a t t e r n s
The first time you start up AvailWorks, the default settings are for one point black line and solid white fill for
objects. If you change the pen width, pen pattern and object fill pattern when no objects are currently selected,
these become the new default settings and remain until changed. Applying a pen width, pen pattern or object fill
to a selected object does not change the defaults.
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17Entering Text and Labels

Pen Widths. Six different line widths may be applied to any object created with the drawing tools, text
boxes, charts, graphs and tables. To change the pen width, first select the object. Tap on the line button and
select the desired pen width from the choices which pop up. 

The pen width selections represent lines from one to six pixels in thickness.

Pen Patterns. The pattern button next to the pen widths palette applies the patterns to the line or border
of the selected object. To change the pattern, first select the object. Tap on the button, and select the desired
pattern from the pop-up menu. To create an object that appears not to have a border, use the same pattern
for the border and the fill.

Pen pattern changes may be applied to drawn objects, text boxes, spreadsheets and graphs.

Fill Patterns. The pattern button to the right of the pen pattern button controls the fill patterns for objects.
The fill pattern pop-up menu also contains an option for None which creates a transparent object. 

SE C T I O N 4

Entering Text and Labels

Entering and Editing Te x t
You may enter text anywhere on the page just as you would in the Newton Notepad application. Text is entered
into a special “layer” on the page, while objects created with the drawing tools, graphs, labels, etc., are in a sepa-
rate object layer. Text may be entered using handwriting, the on-screen keyboard or the optional Newton external
hardware keyboard. The page will automatically scroll to keep the current insertion point on the screen as new
text is being entered.

There are several icons across the bottom of the screen which
provide additional control over the text layer. These include
options to control the recognition settings, pop-up the on-screen
keyboard and set the text style options.
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18 Entering Text and Labels

Selecting a Label Option
Labels are blocks of text which are treated as separate objects in the
object layer of the page. To enter or modify text labels, tap on the
mode selector and choose Label.The tool bar now displays the
options for creating a text box and formatting the text contained
within text boxes.

Label Text Box. This tool is used to create a text box on the page. Select the tool and drag a rectangle
on the page. Upon releasing the pen, you see the Label Editortext entry window. Enter the desired text
and close the window. Text appears in the text box you created on the page. (For a complete discussion
of entering text, see the Label Editor section which follows.)

Each text box has only one font, size, alignment, tab setting and frame setting. If, for example, you want a
block of text in 10 pt plain Geneva and a header in 14 pt bold New York, create two text boxes and assign the
appropriate attributes to each. 

A text box can, however, have more than one style applied to all of its text. For example, you can create text in
bold, underline, and italic by checking all three of those styles in the Text Style pop-up (below).

The settings for all six of the text buttons are indicated by a check mark in their respective pop-up menus. If
no text boxes are selected, the checks indicate the system defaults. These settings are given to all new text boxes
you create. If you select new settings before creating a text box, these stay as the default until you change them.

If one text box is selected, the checks indicate the values applied to that box. If multiple text boxes are select-
ed, the checks show the values of the top text box. If none of the selected objects contain text, there are no checks
on these menus. 

Label Font. To change the font of the text within a block, first select the block. Tap on the font button to
pop up the list of fonts. Select the desired font.

Label Size. To change the size of the text within a block, first select the block. Tap on the Size button to
pop up the list of sizes. Select the desired size.

Label Style. To change the style of the text within a block, first select the block. Tap on the Style button
to pop up the list of styles. Select the desired style. 
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19Entering Text and Labels

Multiple styles are applied to a text box by tapping on the Style button again and adding anoth -
er style. The styles currently applied in the text box are checked in the Style menu. Selecting
Plain cancels all other text styles options.

If more than one text box is selected and a new style applied, the attributes are added to the
existing style for each box. For example, suppose you select two text boxes to change to
Underline.  However, the text in one box is bold and the other is italic. You end up with one text
box with bold underlined text and the other with italic underlined text. 

Alignmentfortext is also selected using this tool. Text is aligned to the left, the right or is
centered.

An example of centered text

Label Frame.This option controls the type of frame around a text box.Select this tool to pop up the
menu. Choose the desired frame or No Frame if you do not want one.

Label Tab. This tool allows you to set the number of spaces between tab settings within the text box.
Tap on the tool and select the desired number of spaces from the list.

Text Wrap. This lets you change the way the text is displayed within the parameters of the box. If Clip
Text is chosen, the text is clipped at the border of the box and is not displayed unless the box is resized. 

The Wrap option allows the text to wrap to the next line when
it reaches the border of the text box. When the box is
reshaped, the text flows and wraps based on the new box
size.

Line of text wrapped.      Same line clipped.

The "Text Wrap" tool also allows the specification of text line spacing, which ranges from sin-
gle-space to double-space.

PelicanWare, Inc.
550 S.W. Park Avenue, Suite 270

Portland, OR  97205-3201
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Entering and Editing Text in the Label Editor
Once you draw a text box, the Label Editor opens automatically to allow for text entry. To open the Label Editor
for editing an existing text box, double tap on the text box. The Label Editor is specially designed to easily com-
bine handwritten words with keyboard input for punctuation and other characters.

This window has three major components: the text entry and display area, the insert or replace words area
and the keypad. The text entry and display area contains all the text for the current text box that you are creating
or editing. The text comes from:

• Handwritten or typed words.
• Punctuation and other special characters from the keypad.
• Text macroswhich can be used to automatically enter complete phrases.
• Live entry from a desktop computer.
• Text files imported from a desktop computer.

Text Entry and Display

Insert or Replace Wo r d s

K e y p a d
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Text Entry and Display. To allow for fast and accurate handwriting recognition, this portion of the Label Editor
has been optimized for recognizing text characters. Punctuation, numbers, and other special characters are avail-
able on the keypad.

All the text for a text box is displayed in this portion of the screen. Text is moved or edited within this area.
Text contained in macrosappears here when a selected macro is applied. Imported text documents and text
entered live from a desktop computer is also displayed in this area.

Text displayed within the text display area. 

To edit a word, double tap on it to pop up the box with the
word choices and the keyboard icon. Tap on the keyboard to

access it. Edit the text using the keyboard.
You may also select one or more words and replace them with other text
handwritten into the "Insert or Replace Words" area.

If the space before each word box is checked, then a space precedes each
word written here when it is displayed above. This is useful for writing in
several words to be inserted at a location above. If, however, you are writ-

ing a word which you want to exactly replace a selected word above, unchecking this box replaces the selection
without adding any extra spaces.

To move a word or a block of text, select it by depressing the pen until a dot appears. Drag across the text to
be moved. Once it is selected, place the pen on it, drag to the new location and release. Tapping Undo returns the
text to its original position.

Tap the Delete All key to delete all the text in the text entry area. Words or phrases are deleted by
selecting them and tapping the Delete key. Undo restores them.

To move to the end of the text, tap the end of selection key . To move to the beginning, tap the beginning of

the selection key . To move one character to the right, tap the right arrow key . To move one character to the
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left, tap the left arrow key . To simply display the current text insertion point without moving it, tap the

insertion point key . (The insertion point remains displayed as long as you hold the pen down on this button.)

Tapping the Tab key after a text entry causes the following entry to be placed at the next tab stop. The
distance between tab stops is adjusted on the page by selecting the text tab key and applying a new setting to the

text box. Tap the carriage return key to create a new line. 
The Keypad. The special keypad is designed for quick access to
punctuation, numbers and other characters and symbols. 

The Keypad contains the most commonly used punctuation
marks. The numbersappear in a format similar to a calculator or a
computer keyboard setup. The most common math symbols appear

directly to the left of the numbers. Below the punctuation keys is a space bar.
To the right of the numbers are four symbol buttons and the macro button. The four pop-up buttons contain

the most common brackets , bullets,mathand money symbols.

Brackets           Bullets        Math Symbols      Money Symbols
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Sample text box showing use of bullet points. The tab indent and the space after the
bullets are automatic features of the bullet point option.

The bullets are automatically preceded by a new line and a tab. To create the
box shown above, type “Meeting agenda:” and tap the bullet from the pop-up
menu. A carriage return is automatically inserted followed by a tab. The bullet

is typed followed by a space. You are ready to type “Sales goals.”

Creating Text Macros
Macrosgive you the option to quickly add text information that you use often without having to re-enter it. For
example, you may create a text block containing your company name, address and phone number and save it as
a macro. The next time you need that information on a page, simply drag out a new text box, and then select the
macro containing that information from the Label Editor window.

The text within a macro is added to a new or an existing text block in the Label Editor.

Macro. This option lets you add a new macro or select an existing macro to use.
To save the text in the Display Area as a macro, tap the Macro button. Select New
from the pop-up list. Write in the name for the macro and tap Save. 

The Select option allows you to choose a macro from the list of saved macros
and apply it to the current text block, delete it from the list or rename it. To delete
or rename a macro, tap on the name of the macro and select the appropriate
option.

Tap the Apply button to add the text within the macro at the insertion point. Tap
within the displayed text in the text display portion of the Label Editor window
to establish the insertion point. This permits you to insert text from a macro in the
middle of existing text.
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Import and Export. Tapon the computer icon to pop up a menu with the import/export options. This
feature allows you to enter text “live” from your computer, import text documents from your desktop
computer and to export the information in the Label Editor window.

Complete information on using this feature is contained in the Import/Export Section of this manual.

SE C T I O N 5

Creating a S p r e a d s h e e t
NOTE: For a detailed discussion of Av a i l Works formulas and functions please
refer to the text file “FuncRef.txt” that came on your installer disk.

To access the options for creating and editing a spreadsheet or
table, tap on the mode selectorand select Table. The tool bar
changes to give you the options for the tables.

Selecting a Table Option
Table Tool. Tap on the spreadsheet icon, move the pen to the page, and drag out a table. The number of
rowsand columnsis displayed in the status area of the tool bar. Additional rows and/or columns may
be added to the spreadsheet after its creation. 

The maximum width of a spreadsheet is 52 columns (labeled A-Z followed by AA-ZZ). The number
of rows is limited by available memory. For optimal performance, create your spreadsheet the size you need,
adding row or columns only when necessary.

The Table Editor is automatically opened after you drag out a table on the page. To access the Table Editor for
an existing spreadsheet, double-tap on the un-selected spreadsheet (de-select it first, if necessary). If you double-
tap on a specific cell, the editor opens with that cell displayed as the selected cell.

The Table Editor allows for the entering of text, numbers, formulas, and functions. Pop-up menus and key-
pads for the most commonly entered items make data entry and cell navigation an easy process. (For a complete
discussion on entering information, see the Table Editor information which follows in this section.) 

Table Title. This tool gives you the option to show or hide the table title. To change the title option,
first select the table. Tap on the title options button to pop upthe menu. Select either the show or hide
option.
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Table Gridlines. There are several options available for gridlinesthat affect the look of a table. Tapping
this option button pops up a menu containing seven options.

The No Grid option hides all of the grid lines. Column widths can still be adjusted with
the grids hidden.

The option Gray displays both horizontal and vertical gridlines in gray. Selecting
the Vert Only or Horiz Only options below Gray gives only vertical or horizontal lines
in gray.

The option Black displays both horizontal and vertical gridlines in black. Selecting
the Vert Only or Horiz Only options below Black gives only vertical or horizontal lines
in black.

Table with no gridlines or frame displayed.

Table with horizontal black gridlines.

Table with vertical gray gridlines.

Table Frame. The table frameoption offers four choices. The options are: no frame, rectangle, round
rectangle and shadow. The illustrations above show the first table without a frame and the other two
with the shadow frame.

Select the table that you wish to change. Tap on the table frame options button. Select the desired
frame from the pop-up menu. 
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Table Font. The font used in the table is changed using this option. Tapping on the fontbutton pops
up a menu showing the available font choices.

Select the table that you wish to change. Tap on the table font options button. Select the desired font
from the pop-up menu.  

Table Font Size. The font sizeused in the table is changed using this option. Tapping on the font size
button pops up a menu showing the available sizes.

Select the table that you wish to change. Tap on the table font size options button. Select the desired
size from the pop-up menu. 

Entering and Editing in the Table Editor
The Table Editor is the area where all the information in the table is entered or edited and consists of several dif-
ferent areas. 

The Table Editor contains three areas: the spreadsheet display area, the cell entry areaand the keypad. Scroll
keysand a Go To Cell keyallow you to move from one area of the spreadsheet quickly.

Tapping on a column letter or a row number pops up a menu with options to insert and delete rows and
columns and cut, copy, paste, clear, fill, format and graph cells.

A default name for the table, Table Title, appears on the top line. To delete this name, scrub over it in standard
Newton fashion. Enter a new name by either writing it in or by double tapping to access the keyboard. The title
appears centered over your spreadsheet when you return to the page view.
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Spreadsheet Display A r e a

Cell Entry A r e a

K e y p a d

Function Keys   Numeric Keypad    Enter and Scroll Keys

Below the title is the spreadsheet display area. It is in this area that the contents of all the cells are displayed.
Information is first entered into the cell entry area and appears in the cell only after the enter key is tapped. 

The lower portion of the screen is the Keypad area. This consists of three types of keypads: function keys,
numeric keypadand enterand scroll keys. The functions which are made available by tapping the function keys
are described in greater detail in the text file “FuncRef.txt” which came on your installation disk.
Cell Entry Area. All of the text for a selected cell is displayed in this portion of the screen. Text may be moved or
edited within this area. The information in a cell of the spreadsheet comes from:

• Words handwritten in the cell entry area.
• Numbers and special characters entered from the numeric key pad.
• Text and special characters entered using the function keys.
• Live entry from a desktop computer.
• Text files imported from a desktop computer.
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To edit a word, double tap on it to pop up the box with the word choices and the keyboard icon. Tap on the
keyboard to access it. Edit the text using the keyboard. 

To move a word or a block of text, select it by depressing the pen until a dot appears. Drag across the text to
be moved. Once it is selected, place the pen on it and drag to the new location and release. Tapping Undo returns
the text to its original position.

Tap the Delete to delete all the text in the text entry area. Words or phrases are deleted by selecting them and
tapping the Del keyon the numeric keypad. Undo restores them.

When entering or editing a formula or function, simply tap on any of the currently visible cells. The cell
address is added to the information in the Cell Entry Area. 

The Cancel Button. This icon appears in the space above the cell entry after a change has been made to a
selected cell. Tapping the cancel button prior to entering the cell information restores the cell to its original
state.

For example, in FigureA below, the cancel button does not appear since no changes have been made to the
the cell contents. However, in Figure B, the cell contents have been changed, but not yet entered, and therefore
the cancel button appears. Tapping the cancel button at this point restores the information to that in Figure A. 

Figure A Figure B

The Delete Key. The delete key removes the contents from a cell. The information is initially erased in
the cell entry area. It is deleted from the spreadsheet area once enter is tapped. To replace the contents

of a cell, select the cell, tap delete, put the new information in the cell entry area and tap enter. The new informa-
tion replaces the former cell contents in the spreadsheet display area.

Auto Recalculate. The default setting for Auto Recalculate is for it to be off (no check mark). This
speeds up the entry of data because Av a i l Works does not have to calculate the whole spre a d s h e e t

every time a cell is changed. To activate recalculate and recompute all values, tap on the box to check it.
Tapping the close button in the bottom right corner of the screen enters information in the cell entry area and

also recalculates the spreadsheet if necessary, before returning you to the page view.
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The Numeric Keypad. The numeric key pad is set up in a nine-key format of the numbers
surrounded by the most commonly used spreadsheet characters. Tapping on any number or
character enters it in the cell entry area.

The delete key on this keypad allows you to delete single characters, or individual words
from the cell entry area. To delete a character or characters, tap to the right of the character to

establish the insertion point and tap delete. To delete a word, first select the word, then tap delete. 
The Function Keypad. This keypad contains eight separate pop-up buttons. The A-M and N-Z but-
tons contain the letters of the alphabet to facilitate entry of cell addresses. The A-M also contains the $
for use in creating absolute cell references. (See the Using Formulas and Functions Section of the
“FuncRef.txt” file for more information on absoluteand relative cell references.)

For example, to enter the sum of cell A2 and B6 (=A2 +B6) into cell D8, tap on cell D8 to select it.
From the numeric keypad, tap the = sign. Tap the A-M function key and select A. Tap 2 followed by the + sign
from the numeric keypad. Tap the A-M button again and select B. Tap 6 in the numeric keypad followed by enter.
If Auto Recalculate is checked, the sum of cells A2 and B6 appears in cell D8.

The other six function keys pop up menus for strings, general math, statistics, time & money, conditionals,
and trigonometry. Each pop-up menu has the category name of the functions as a header. To view brief, on-line
descriptionsof each functionwithin the category, tap on the header name.

The functions are divided into groups on the pop-up menus. The functions within each group operate in a
similar manner. (See the“FuncRef.txt” file for details on functions.)

The Go To Button. Below the Spreadsheet Display Area is a button that shows the
address of the currently selected cell. Tap on this button to pop up the Go To menu. 

The first four options take you to each of the four corners of the spreadsheet. The
cell reference for each of these corners is displayed in parenthesis. For example, if your
spreadsheet is six columns by 10 rows, selecting Bottom Right moves you to cell F10. 

The last option, Go To Cell..., gives you a box to enter a specific cell designation and moves you to
that cell. Type in the column letter and the row number and tap Go. 

The Enter and Scroll Keys. The enter and scroll keys from the keypad perform several func-
tions. Once you have information in the cell entry area, you must tap the enter key to have it
entered into the cell. 

Tapping one of the eight directional arrows also enters the information into the cell and
moves you to another cell. Tapping the close button in the bottom right corner of the screen

enters information in the cell entry area and recalculates the spreadsheet before returning you to the page view.
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The scroll arrows move you one cell at a time horizontally, vertically or diagonally in the spreadsheet. When
you reach the edge of your spreadsheet, the diagonal arrows move vertically, either up or down.

Import and Export. Tap on the computer icon to pop up a menu with the import/export options. This
feature allows you to enter text “live” from your computer, import text documents from your desktop
computer and to export the information in the spreadsheet.

Complete information on using this feature is contained in Import/Export Section of this manual.

Formatting in the Table Editor
Tapping on either a column heading letter or a row number pops up the menu shown here. The
functions on this menu act on both columns and rows to insert or delete, cut, copy, paste and clear
the contents,and to fill, format and link a graph to cells (Note that unlinked, or “stand-alone”
graphs may also be created directly using the Graph tools described later).

When working with these features, it is recommended that you turn Auto Recalculate off. This
speeds up any changes you are making. Once you are done making changes, check Auto Recalculate
and your whole spreadsheet updates.

Inserting and deleting columns, cutting, copying and pasting cells, causes changes to occur in
formulas and functions that reference a range of cells. For example, cell A7 contains the formula
Sum (A1:A6). The insertion of a new row after row 4 results in the formula Sum (A1:A7) in cell A8. 

Functions that reference a direction such as SumAboveand AvgLeftoperate differently. They calculate the
numbers in a column or row in the specified direction until text or a blank cell is encountered. Inserting or delet-
ing a column or row or cutting the contents of a cell, could cause a total to be changed due to the creation of a
blank cell or the deletion of one. 

It is also possible to delete a cell or cell contents that is important to the calculation of a function somewhere
else on the spreadsheet. When Auto Recalculate is turned on, you hear an error soundwhich indicates that the
function cannot calculate. You also get a reference error message within the cell or cells which contain the errors.
Insert. Columns and rows are inserted in the spreadsheet using the Insert command. New columns are inserted
to the left of the selected column. New rows are inserted above the selected row.

For example, to insert a new column between columns C &D, tap on the header for column D to pop up the
menu. Tap on Insert. The new column is inserted to the left of D. The maximum number of columns is 52.

To insert a new row between rows 4 and 5, tap on row 5. Tap on Insert. The new row is inserted above row 5.
The number of rows is limited only by available memory.
Delete. Delete removes the selected column or row from the spreadsheet and renumbers the remaining rows or
columns.  
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Cut. This option allows you to cut the contents of specified cells. Only the contents of one row or
one column may be cut at a time. The specified range may go forward or backward from the
beginning cell. 

For example, to cut the cell contents from A1 to A8, select cell A1. Tap on the column header
A and select Cut from the menu. In the dialog box, write or type in 8 as the To Row. Tap the Cut

button. 
You could also start by selecting cell A8. Then choose Cut. Type in 1 as the To Row. The range of cells is now

reversed to be from the bottom to the top or from A8 to A1.
To cut the contents of just one cell, tap on the cell and select Cut from either the row or column pop-up menu.

In the resulting dialog box, tap the Cut button without entering a To Row or To Column number. To cut the con-
tents of the entire row or column, tap the All button.

The information that has been cut is saved in memory and may be placed into another cell or spreadsheet
using the Paste feature. The cell references for formulas and functions are adjusted appropriately when the infor-
mation is pasted into the new location.

Copy. Copy works the same way as Cut except that it does not remove the contents of the cells.
This command copies formulas and functions as well as numbers and text. Information that has
been copied may be pasted into another cell in the same spreadsheet or in another spreadsheet.
Paste. Thiscommand pastes any information that has been copied or cut from one cell group
into another. To paste cell contents in a new location, first perform the Cut or Copy command.

Select the cell where the information is to be pasted. 
Tap on the column header and select Paste for a vertical entry. Tap on the row number and Paste for a horizon-

tal entry.
Information is easily changed from horizontal to vertical by cutting the cells from a row and pasting them

into a column. To change from vertical to horizontal, cut the cells from a column and paste into a row. The fol-
lowing illustration shows the affect of this.

Spreadsheet with numbers in a vertical column. Cut removes the cell
contents from the column.

Paste in a row returns the information 
horizontally rather than vertically.
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Clear. This command removes the contents of the cell but does not retain the information in
memory. Undo reverses the operation.

Fill. The Filloption allows you to repeat the contents of one cell into a range of cells, either hori-
zontally or vertically. The fill command works with text, numbers, formulas and functions.

When fill is used with formulas or functions, the cell references are adjusted for each new col-
umn or row. For example, you have 10 columns of numbers starting in column A and you want a
sum at the the end of each column. Rather than enter the SumAbove function 10 times, you enter
it once and use the Fill option to fill the other 9 cells in the row where you want the totals. Each

gives the sum of the cells above it.
References to cells also changes. For example, the formula =A1+A2 in row 3 becomes =B1+B2 and =C1+C2

when Fill is used to fill across row 3. 

Format. The format options allows you to select a range of cells and format the
numbers, the alignment and the style. Formats are applied to horizontal columns or
vertical rows of cells.

Tap on the cell where the formatting is to begin. Tap on the column letter if the format change is
to be applied to a column. In the dialog box illustrated at the left, type in the row number to
identify the last cell affected by the format change and tap Format.  If no To Column is entered, the
formatting applies only to the single cell. Tap All to apply the format to all the cells in the column
or row.

Once you are into the format dialog box, make the change to number format, alignment, and
style by tapping on the selector to pop up the menu for each. Once all settings are made, tap Apply to close the
box and apply the formatting to the cells. 
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Numbers. To change the format of a group of numbers, tap the Numbers button. You have the option
to change the number of decimal places, the format of a negative number for plain numbers or dollar
amounts and the number of decimals for a percentage amount.

Tap the appropriate option from the list. It appears in the format box next to the Numbers option.

Alignment. The alignment option lets you adjust the text or number to the left, right or cen-
ter of the cell. Tap the desired alignment and the Apply button to apply the formatting to
the cells. Alignment changes are not displayed in the Table Editor but are in the page view.

Style. The styles available are plain, bold, italic, underline, and outline. Only one style is
applied to a cell. Tap on the desired style and tap Apply to apply the style to the specified
range of cells.

Often a column of numbers contains an underline after the last entry to indicate that the
entry in the cell below is the result of performing a mathematical function on the preceding
numbers. To create this effect, use the underline format for the last cell entry in the column.

Formatting in the Page Vi e w
Many of the options affecting the overall appearance of a table are changed in the page view. While in Table
mode, the tool bar contains options for changing the title display, the grid lines, the table frame, as well as the
font and font  size.If any of these options are changed when no spreadsheet is selected, the settings become the
default for future tables. (See the information earlier in this chapter for details on these options.)

The pen width, pen patternsand fill patternsall apply to tables in the same way they are used for objects cre-
ated with the drawing tools.(See the Working With Drawing Tools Section of this manual for more details on these
tools.)
Column Width. The column widthis also changed in the page view. To change the width of a column, place the
pen within the column of an unselected table. Drag right to make the column wider and left to make it narrower.
Release the stylus to lock in the change.

The message in the status bar changes to show that a column width change is in effect. For example, if you
tapped in column B, the message says “Resizing Column B.” Also a line indicating the right edge of the column
appears and moves as you drag the stylus.
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Linked Tables and Graphs
One, or more, graphs can be linked to any spreadsheet for "live" graph updates.  Graphs can also be unlinked at
any time to produce a "static" graph with a copy of the data from the formerly linked table. An existing graph
can be linked to any existing table. A new linked graphcan also be created completely from within the table edi-
tor.

Creating A Linked Graph From The Table Editor - 
One Data Series
To create a linked graph from the Table Editor, first open the editor
by double-tapping on the desired table. Once in the Table Editor, tap
the header of the row or column to be graphed. Note the "Graph…"
option in popup menu of cell options. Selecting the "Graph…"
option will produce a linked graph dialog.  

This dialog allows specification of the cells to be graphed, and of the
cells containing the data labels, titles, etc. There is also a popup but-
ton for selecting the type of graph to create.

The example at left shows how the dialog would appear after select-
ing "Graph…" from row 7, and entering column B and C as the data
to be graphed (i.e., cells B7 to C7).

The other items allow the specification of cells containing labels and titles, if desired. Note that any of these titles
or data values may also be entered manually later in the graph editor. The relationship between the specified
cells and the final graph are demonstrated on the next page.

Create Linked Graph Dialog - 
One Row Data Series
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Links Between Table and Graph
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Once a linked graph is created, it can be double-tapped for further
editing (make sure that the graph is not selected before double-tap-
ping). The Graph Editor for the linked graph created above would
appear as shown at left.

The "Unlink" button can be
tapped at any time to detach
the graph from the linked
table, producing a static graph.
A confirming dialog would
then appear:

If "OK" is tapped, the table values are copied into the appropriate areas
of the Graph Editor, and the button title changes to "Link."

Tapping the "Link" button at this point would produce a popup menu of
all the tables currently on the page. Selecting a table from this popup
would create a link to that table, so that cell addresses referring to that
table could be entered for any of the Graph Editor items.

Automatic Unlinking of Graphs
Graphs are automatically detached from a linked spreadsheet in two
cases.  First, if the graph is Cut or Copied and then Pasted back on any
page, the Pasted graph will be a static copy of the original linked graph.
Second, if a spreadsheet is Cut or deleted from the page, any linked
graphs will automatically be converted to static copies of the spreadsheet
data before the spreadsheet is removed from the page.

Graph Editor After Unlinking

Graph Editor For Linked Graph
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Creating A Linked Graph From The Table Editor - 
Two Data Series
The process is similar for creating linked graphs with two data
series. Once the linked graph dialog is opened, select the graph-types
popup, and then choose any of the two-series graph types. In this
Column B graph example, a double bar graph is selected, and the
linked graph dialog is filled-in as shown at left

Note that a "Second Series" column (or row) entry area appears
whenever the graph type accommodates two data sets. The second
data series is assumed to be in the same rows as the first series (if
this is not the case, the values for the second series can always be
edited later in the Graph Editor). Likewise the second series name is
assumed to be in the same row as the first series, but in the column
specified for the second series.

These specifications would produce the graph below:

Linked Double Bar Graph Create Linked Graph Dialog - 
Two Column Data Series
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Double-tapping to view the Graph Editor would show the values filled-in as shown below-left. Again, if "Unlink"
was tapped, a static copy of the table data would be placed into the graph specifications, as shown below-right.

Creating A Linked Graph From The Graph Editor
Linked graphs can also be created from the Graph Editor, by tapping the "Link" button and selecting a spread-
sheet to which to link.  Cell references, such as "A1" or "c3" (capitalization does not matter) may be entered for
any of the editor fields in a linked graph.

Not all of the fields, however,  must contain cell references.  Each field may contain either an actual value (e.g.,
"125.73") or a linked spreadsheet cell reference (e.g., "B5").

Graph Editor After UnlinkingGraph Editor For Linked Graph 
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SE C T I O N 6

Charts and Graphs
The graph mode gives you options to create seven different types
of graphs and charts. The graph editor provides options for speci-
fying the ranges, patterns, number of divisions and the legend.

Selecting a Graph Option
Graph. Tap on this option, select the desired graph or chart from the pop-up menu and drag out a
graph. The options are shown below. Once you have drawn the graph, the Graph Editor window
opens. The Graph Editor contains options for modifying your graph.

Single bar chart
Double bar chart
Stacked bar chart
Single line graph
Double line graph
Line and bar chart
Pie chart

Graph Title. This tool gives you the option to show or hide the graph title. To use the title option, first
select the graph. Tap on the title options button to pop up the menu. Select either the show or hide
option.

GraphGridlines. There are several options available for gridlines that affect the look of a graph.
Tapping this option button pops up a menu containing seven options.
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The No Grid option hides all of the grid lines.
The option Gray displays both horizontal and vertical gridlines in gray. Selecting the Vert

Only or Horiz Only options below Gray gives only vertical or horizontal lines in gray.
The option Black displays both horizontal and vertical gridlines in black. Selecting the Vert

Only or Horiz Only options below Black gives only vertical or horizontal lines in black.

Graph Frame. The graph frame option offers four choices. The options are: no frame, rectangle, round
rectangle and shadow.

Select the graph that you wish to change. Tap on the graph frame options button. Select the desired
frame from the pop-up menu.

Graph Font. The font used in the graph is changed using this option. Tapping on the font button pops
up a menu showing the available font choices.

Select the graph that you wish to change. Tap on the graph font options button. Select the desired
font from the pop-up menu.

Graph Font Size. The font size used in the graph is changed using this option. Tapping on the font
size button pops up a menu showing the available sizes. 

Select the graph that you wish to change. Tap on the graph font size options button. Select the
desired size from the pop-up menu.

Editing a Graph
The options for editing a graph are in the Graph Editor. The Graph Editoropens automatically when you create a
new graph. To edit an existing graph, tap anywhere on the graph (not the legend) to open the Graph Editor.
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The Graph Editor dialog box shown below is the one that is opened when any of the bar or line charts are
selected. Within the Graph Editor, you assign the series names, the graph title, the series values and the legend
settings

.

Graph Data Entry A r e a

Graph Settings A r e a

Graph Editor for Bar and Line Graphs

The Graph Editor dialog for pie charts contains settings that are unique to them. You can assign a pattern to
each pie slice, and display the values as numbers or percentages on each slice or in the legend. The illustration on
the following page shows the dialog box for editing a pie chart.
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Graph Data Entry A r e a

Graph Settings A r e a

Graph Editor for Pie Charts

Graph Data Entry Area. At the very top of the Graph Editor is a line for entering a title. Double tap the existing
title to pop up the keyboard for editing. Delete a title or a word in the title by scrubbing over it. A title may also
be handwritten. Below the title is the “Link” button described in detail in the Creating a Spreadsheet Section.

Below the right side of the title is the space for writing in theseries names. Bar and line charts are allowed
one or two series, and pie charts have one. They are edited in the same way as the title. 

In the cells directly below the series name are the values for that series. To enter values, handwrite them in or
double tap to get a numeric keypad. Delete values by scrubbing them, or use the delete key in the keypad. Use
the up/down arrow key on your Newton to scroll the list of values.

Thelabels for the graph appear in the left column. These are also edited in the same manner as the title. Use
the up/down arrow keys on your Newton to scroll the list of labels.

When creating pie charts, tap on eachpattern palette to the right of the value to select the desired pattern for
that slice.
Settings for Bar and Line Graphs. The features in this area control the look of the graph. It is here that you
change the patterns, the range of values, the number of divisions and the legend display.

The four buttons next to Series Type indicate what type of graph is currently set. By changing the button set-
tings, you change the graph. Suppose, for example, you drew a bar chart. You later decide to display the same

AvailWorks Manl  8/6/96 4:04 PM  Page 42



43Charts and Graphs

data as a line graph. Simply change the buttons to the Line setting and it redraws as a line graph. (You cannot
change a line or bar graph into a pie chart, or a pie chart into a line or bar graph.)

When creating a bar and line graph, it is best to make series 1 the bar and series 2 the line. It draws as in
Illustration A below. If you set it up in reverse, the graph may draw as in Illustration B, depending on the nature
of your data.

Illustration A Illustration B

The check box for Stacked is available only when both buttons are set on the Bar option. When the box is
checked, the bars draw one above the other. When it is not checked, they appear side by side.

The pop-up pattern palettes control the pattern for the bar or the line in the graph. Tap on the palette under
the series that you want to change. Select a pattern from the palette.

Four Views of the Same Data

Double Bar Chart Stacked Bar Chart

Double Line Graph Bar and Line Graph
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Values. The items in the value box control the number of gridlines and
the minimum and maximum value displayed. 

If Auto is checked, AvailWorks automatically decides on an appro-
priate range of data, determining the minimum and maximum values.

The values are determined by the nature of your data. For example, a data range with the highest value of 47
returns a maximum value of 50. If the range has the highest value of 4.75, the maximum value is 5. If the stacked
bar chart is used, Auto adjusts to a maximum value large enough to encompass the sum of the two variables
making up the tallest stack.

To override the automatic settings, tap on the box to remove the check mark. This is especially useful for cre-
ating two graphs with the same minimum and maximum values for comparison purposes when the source data
has different high and low numbers.

To edit the default values, double tap in the box containing the value. This pops up a numeric keypad for
entering the new numbers. Values are also edited by scrubbing out the existing number and handwriting in the
new one.

Bar and Line Graph Legend. The legend contains two boxes filled with
the patterns of the bars or lines. The series name appears beside the appro-
priate box.

The legend position buttons determine the placing of the legend in rela-
tion to the graph. Tap on the desired button to change the legend position. 

If you do not wish to have a legend show, tap on the Show box to remove the check.

Legend placement at right center      Legend placement at top right

Graph Settings for Pie Charts. The Graph Editor for pie charts contains the options to show the variables on
the pie or in a legend. The numbers may be shown as actual values or percentages.
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To display the values, tap in the Show box to check it,
and tap the button to specify whether you want them dis-
played in the legend or in the slice. To display the percent-
ages, tap the Show box and specify whether you want them
in the legend or the slice. Both the values and the percent-
ages may be displayed simultaneously if desired.

Pie chart with values in the slice.         Pie chart with percentages in slice 
and values in the legend.

Pie Chart Legend. The legend contains boxes filled with the patterns to correspond with each slice of the pie.
The labels appear next to each slice.

The legend positioning operates the same for the pie charts as it does for the bar and line graphs. You hide
the legend entirely by tapping the Show button to remove the check.
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SE C T I O N 7

File Management
AvailWorks allows you to file, beam, fax, mail and print your page. Filing gives you options to specify the page
name and the destination folder.

Filing, Viewing and Naming Pages
File. To file an AvailWorks page, tap the folder button at the upper-right of your
Newton screen. The list of your current folders is displayed. Tap the appropriate
button for the folder you want and tap File.

To create a new folder or to edit the name of an existing one, tap the Edit Folders
button. (See your Newton manual for more information on creating and editing
folders.)

A page received by mail or beam is filed in the folder of the same name as the sender’s folder if one exists.
Otherwise, it is goes into Untitled Pages. For example, the sender mails you a page from a folder called Business. If
you have a Business folder, the document is filed there when you select Put Away. If you are not sure in which
folder it went, select All Pages, and scroll through the pages, or view the list of file names.
This dialog also allows you to move pages from your PCMCIAcard into the memory on the Newton or from the

Newton to the card. If a page is stored on the card, the Filing button (folder icon) is shown with a triangle inside
it.
Name. To see a list of all the stored pages by name, select Open from the File menu, or simply tap the button
between the up and down arrows.  The currently displayed page is initially hilighted in the list.

Tap this button to see a list of all the files within the selected folder.

The list displays the names of the pages within the selected folder. If
All Pages is selected, the list contains all of the pages from all folders. 
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All new pages are given a default name of Untitled followed by the date
and time. To rename a page, choose the File menu Rename selection, tap on
the name in the list and tap the Rename button. A dialog box opens to allow
you to make the desired edits to the name. Tap the Change button to save
the edits and close the dialog box. 

If you open a folder that does not contain any pages, a new, blank page
is automatically created. If you do not use this page, it is deleted when you
exit AvailWorks.
To permanently delete a page, choose the File menu Delete selection, tap on

the name in the list and tap the Delete button.  The currently displayed page may also be deleted using the Action
menu (top right envelope icon) Delete option.

Folder Ta b
The names of all the existing folders are displayed in a menu by tapping on the name in the
folder tab. All of your AvailWorks pages appear in one of the existing folders or with the
Untitled Pages. You scroll the items within the selected folder by using the up/down arrow
keys at the bottom of your Newton screen. You view all of your pages by selecting the All
Pages option.

Export to Notepad. Information in text boxes, spreadsheets and charts is moved to the Notepad area of your
Newton using this File menu command. Charts and spreadsheets appear as tab delimited text files. You may also
export all or part of your page to the notepad as a single “picture.”

Import/Export to Mac/PC. This File menu option allows you to export all or
part of your document. The information in text boxes, spreadsheets and charts
is exportable. Spreadsheets and charts export as tab delimited text files.
Drawings do not export.

Select the item or items you want to export. Select Export from the File
menu. Tap the Export button within the dialog box to send the file.

Exporting requires the use of a terminal program capable of receiving text
files and a serial cable to connect your Newton to the desktop computer. Tap
the “i” button for on-line help or see the Import/Export Section  in this manual

for details (importing of text to spreadsheets and text boxes is done through menus found in the Table editor and
the Label Editor).

Once this dialog is opened, text may also be sent from the desktop terminal program to be inserted at the cur-
rent text insertion point on the AvailWorks page.
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The Action Button Menu
The A c t i o n button(the envelope icon) contains the options for printing, mailing, faxing and
beaming. You also have options for moving pages between cards, transferring information to
your desktop computer, and deleting the currently displayed page.
Print Page. AvailWorks outputs an 8 1/2 x 11 inch or A4 page using the print feature avail-
able in your Newton. Before printing from AvailWorks, make sure you are properly connected
to the printer following the instructions in your Newton manual or the Newton Print Pack
manual. From the pop-up menu, select Print Page. Make sure the appropriate printer is dis-

played. If not, tap the mode selector next to Printer to see the list of available printers.
To see a preview of your page, tap the Preview button. Once you have viewed it, tap the close box in the lower

right corner of the preview window. Tap the Print button to print the page immediately or to send the page to the
Out Box.
Fax. Locate the page you wish to fax. Select Fax from the Action button menu. All the normal options, as covered
in the Newton manual, are available when faxing an AvailWorks page. 
Mail. Locate the page you wish to mail. Select Mail from the Action button menu. All the normal options, as cov -
ered in the Newton manual, are available when mailing an AvailWorks page. Newton users who have
AvailWorks can open, view and file a page received by mail.

The option for Text Only mails the information in text boxes, spreadsheets, charts and graphs. Spreadsheets
and charts become tab-delimited files. Drawings are not included when this option is checked.
Beam. Locate the page you wish to beam. Select Beam from the Action button menu. All the normal options, as
covered in the Newton manual are available when beaming an AvailWorks page.
Duplicate. The Duplicate option makes a new "Untitled" copy of the currently displayed page.
Delete. The trash can appears and the entire page is deleted when you select this option. 

Tips for Printing, Faxing and Mailing
On occasion, you may experience problems printing, faxing or mailing very complex pages from AvailWorks.
This may result from memory constraints on the Newton. If problems arise, try the following:

• Quit AvailWorks before attempting to send the file from the Outbox. 
• If the page still does not go through, reset your Newton and send the file again.
• Simplify the items on the page or move some of them to a second page.

Also, please note the following regarding PostScript printers:
• The Newton does not support Outline fonts on PostScript printers. Any text in the outline style is converted to
plain text when printed on these printers.
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• Some PostScript printers have a smaller printable area than other types of printers, such as the StyleWriter. On
these printers, items on the page may be cut off if they are placed too close to the edge of the AvailWorks page.
• Some PostScript printers substitute their own fill patterns for some of the Newton screen patterns. Experiment
with your printer to determine which are the best patterns to use.

SE C T I O N 8

I m p o r t / E x p o r t
AvailWorks allows the exchange of information in text form with desktop computers. Importing and exporting
require the use of a terminal program on the desktop computer and a serial cable to connect the Newton with the
computer.

Setting up the Terminal Program
The settings of the terminal program are as follows:

• 9600 Baud
• Parity - None
• 8 Data Bits
• 1 Stop Bit
• XOn/XOff Handshaking
In some terminal programs, you may need to change the setting to “Echo On” in order for the text to appear

in the terminal program as you type or export. You may also need to disable the “Strip 8th bit” or “Strip hi bit”
option in the terminal program as well.

The computer and the Newton are connected to each other using a serial cable. Connect the cables the same
as you do when using the Newton Connection Kit. 

On the Macintosh, plug into either the printer port or the modem port. When using the printer port, set
AppleTalk to Inactive. When using the modem port, be sure the modem driver is disabled to allow access to the
port by the Newton. If you are working with a PowerBook with an internal modem, select the External Modem
button in the control panel.

I m p o r t i n g
Both the Table Editor and the Label Editor contain the computer icon as illustrated. Tap on the icon to
pop up a menu with the import/export options.
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About Import/Export. Tap on About Import/Export to access the on-line help screen.
This contains key information for setting up a terminal program as well as how to
import and export text files. 

Connect/Import. When you select this option, the computer icon changes to indicate that the Newton
is ready to connect to the desktop computer. Launch your terminal program on your desktop com-
puter and be sure all the settings are as described previously.

To perform live import, simply type text into the entry area of the terminal program. Once you
press Enter or Return on your computer keyboard, the text is sent to your Newton. 

It is also possible to import information from other applications on you computer. These files must be saved
as tab delimited text files in whatever application you are working. Within your terminal program, select the
option for sending a text file. The contents of the file are imported into AvailWorks.
Import in the Label Editor or Text Layer. When you are in the Label editor, or importing into the text layer, the
text comes into the text entry area at the current insertion point. Each time you enter text on the desktop and
press enter or return, a new line is created in AvailWorks. To suppress this return on the Newton, type the esc
(escape) key on the computer keyboard before pressing return.
Import in the Spreadsheet. The spreadsheet has two basic types of import options: by column and by row.

To import live data into a column, select the starting cell in AvailWorks. In your terminal program, type the
contents for that cell followed by a return. This moves you to the cell directly below. Continue to enter a cell
value, followed by the return until all the data is entered. You can enter data in this manner into any of the exist-
ing cells in the spreadsheet. If you need more rows, create them before entering the data.

You can also import a text file from another application that contains one column of data. As with the live
entry, make sure you have enough rows created and select the start cell. Import the text file as previously men-
tioned.

To import live data by row, select the starting cell in AvailWorks. In the terminal program, type the contents
of the first cell followed by a tab. Continue across the row, entering all the cell values, following each with a tab.
Once the end of the row is reached, press return. The data is then transmitted to AvailWorks. 

Make sure that you have the correct number of columns established in AvailWorks before you begin. Any
data that extends beyond the last AvailWorks column is ignored on an import. New rows are automatically creat-
ed as the data is imported.

This method is also used for importing tab-delimited text files from the desktop computer. Select your start
cell in AvailWorks. Use the “send text” option in your terminal program and select the file to send. As in live
data entry, be sure you have the correct number of columns set in AvailWorks before importing.
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Export. This option allows you to export the contents of the the Label and Table editor windows to the terminal
program. From there, it is easily copied to a word processing program or a spreadsheet for viewing and/or mod-
ification.

To export the entire contents of a page or selected items, see the information under Export in the File
Management Section.
Disconnect. Once you are finished with importing or exporting, select Disconnect. This discontinues the connec-
tion with your desktop computer. The computer icon on your AvailWorks window returns to its original state.
AvailWorks also automatically disconnects for you if necessary when you close the editor window.

Note the following when using the Import/Export options:
• When importing and exporting large text files, be sure that the “Sleep” feature in Newton Preferences is set

to “Never.” If the Newton goes to sleep in the middle of importing, data could be lost. 
• When importing a text file from a desktop computer via a terminal program, you must put a carriage return

after the last line of text to transmit. This applies when entering text directly as well as importing text files creat-
ed in word processing programs and spreadsheets.
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SE C T I O N 9

Using ClipArt Libraries

The Avail ClipArt Installer
The ClipArt Installer allows you to browse clip-art libraries on the Newton.  You may also install any or
all images onto your Newton, or remove any or all installed images from your Newton.   Each Installer
contains a different set of ClipArt images.  When a ClipArt Installer application is run, it opens to the

ClipArt "Browser" screen, as shown below.

The specific range of clip-art images contained in an
Installer is indicated by the title next the "Library" label.
In the example at right, the "Business & Workplace"
library images with names starting from "A" to "G" are
available.  The Avail ClipArt libraries have been segment -
ed in this way so that very little memory is required to
run any particular installer.

You may keep as many ClipArt Installers on your
Newton as desired.  In most cases, you will simply put an
installer onto your Newton, select any ClipArt images to
install, and then remove the Installer from your Newton.
Note that copies of the Images remain on your Newton
until deleted with "Remove" options described later.

Also note that installing or removing copies of the
ClipArt to or from your Newton does not affect the origi-
nal Images that are contained in the ClipArt  Installer
application.  The original images are always available as
part of the original Installer package.  As a result, you do

not need to worry about "permanently deleting" ClipArt images from your Newton -- they can always be re-
installed again using the appropriate Installer.

ClipArt Browser
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The scroll bar below the displayed image can be used to scroll forward or backward through the ClipArt images.
The built-in Newton up- and down-arrows may also be used to scroll through the images, if desired.

The pop-up selections at the upper-right of the displayed image allow you to control whether the image is dis-
played at full-size (100%) or at a reduced-size, if necessary, to fit the display area.  If the image is displayed at a
reduced-size, then the percentage of its full size is displayed above the image.

When the Library images are being displayed, there are two options buttons below the image area: "Install" and
"Install All."  Tapping "Install" will append a copy of the displayed image at the end of the Newton's set of
Installed ClipArt.  Similarly, tapping "Install All" will first prompt you to make sure you want to continue, and
then append copies of all the images onto the set of Installed ClipArt on your Newton.

Tapping the Library selector provides a pop-up menu where you may select  
either the particular Library offered by this ClipArt Installer, or the Installed
ClipArt already present in your Newton.

Selecting "Installed ClipArt" displays the images already installed onto your Newton, and changes the buttons
below to "Remove" and "Remove All."  

Using these options, you may remove one or more images from you
Installed ClipArt database.

Bundled ClipArt Images
Two ClipArt libraries have been included free, for your use with
AvailWorks.  The first is a collection of 80 small "Interest and Activity
Icons" (ClipArt.pkg).  The second library, "ClipArt Sampler"
(ClipArtS.pkg),  provides sample images from some of the separate-
ly-sold Avail ClipArt For Newton libraries.

The following pages show the "visual index" to the images that you
have received with AvailWorks.
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Business Symbols
500+Images

Newsletters & Flyers
100+ Images

Special Occasions
100+ Images

Leisure, Family & Education
100+ Images

Business & Workplace
100+ Images

Presenter Starburst

Border06 Framer07

Pumpkin7 Santa2

Barbecue Golfer

Attack HappyGuy

CLIPART
AVAIL

FOR N EWTON™

ClipArt Sampler
Visual Index
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Art Dance1 Dance2 Dance3

Event1 Event2 Event3 Event4

Event5

Dates1 Dates2 Dates3 Dates4

Food1 Food2 Food3 Food4 Food5 Food6 Food7

Food8 Food9

Biz1 Biz2 Biz3 Biz4

Bldg1 Bldg2 Bldg3 Bldg4 Info1 Info2

Info3 Info4 Kids1 Kids2 Music1 Music2 Music3 Music4

Music5 Night1 Night2 Night3 Note1 Note2 Note3

Point1 Point2 Point3 Point4 Point5 Shop1

Shop2 Sight1 Sight2 Sight3 Sight4 Sport1 Sport2 Sport3

Sport4 Theat1 Theat2 Theat3 Ticket1 Ticket2 Travel1 Travel2

Travel3 Travel4 Travel5 Travel6 Travel7 Travel8 Travel9 Travel10

Point7

Note4

Point6

Interest & Activity Icons
Visual Index

CLIPART
AVAIL

FOR N EWTON™
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SE C T I O N 1 0

Software License

PLEASE READ THIS LICENSE CAREFULLY BEFORE USING THE SOFTWARE. BY USING THE SOFT-
WARE YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS LICENSE. IF YOU DO NOT
AGREE TO THE TERMS OF THIS LICENSE, PROMPTLY RETURN THE PRODUCT TO THE PLACE
WHERE YOU OBTAINED IT AND YOUR MONEY WILLBE REFUNDED.

1. License. The application, demonstration, system and other software accompanying this License, whether on
disk, in read only memory, or on any other media (the “Software”), the related documentation and fonts are
licensed to you by PelicanWare, Inc. You own the media on which the Software and fonts are recorded but
PelicanWare, Inc. and/or PelicanWare, Inc.’s Licensor(s), if any, retain title to the Software, related documenta-
tion and fonts. This License allows you to use the Software and fonts on a single Newton Product (which, for
purposes of this License, shall mean a product bearing Apple’s Newton logo), and make one copy of the
Software and fonts in machine-readable form for backup purposes only. You must reproduce on such copy
the PelicanWare, Inc. copyright notice and any other proprietary legends that were on the original copy of the
Software and fonts. You may also transfer all your license rights in the Software and fonts, the backup copy
of the Software and fonts, the related documentation and a copy of this License to another party, provided the
other party reads and agrees to accept the terms and conditions of this License.

2. Restrictions. The Software contains copyrighted material, trade secrets and other proprietary material and
in order to protect them you may not decompile, reverse engineer, disassemble or otherwise reduce the
Software to a human-perceivable form. You may not modify, network, rent, lease, loan, distribute, or create
derivative works based upon the Software in whole or in part. You may not electronically transmit the
Software from one device to another or over a network.

3. Termination. This License is effective until terminated. You may terminate this License at any time by
destroying the Software and related documentation and fonts. This License will terminate immediately with-
out notice from PelicanWare, Inc. if you fail to comply with any provision of this License. Upon termination,
you must destroy the Software, related documentation, and fonts.

4. Export Law Assurances. You agree and certify that neither the Software nor any other technical data
received from PelicanWare, Inc., nor the direct product thereof, will be exported outside the United States
except as authorized and permitted by the laws and regulations of the United States. If the Software has been
rightfully obtained by you outside of the United States, you agree that the direct product thereof, except as
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permitted by the laws and regulations of the United States and the laws and regulations of the jurisdiction in
which you obtained the Software.

5. Government End Users. If you are acquiring the Software and fonts on behalf of any unit or agency of the
United States Government, the following provisions apply. The Government agrees:

(i) If the Software and fonts are supplied to the Department of Defense (DoD), the Software and fonts
are classified as “Commercial Computer Software” and the Government is acquiring only “restricted rights”
in the Software, it’s documentation and fonts as that term is defined in Clause 252.227-7013(c)(1) of the
DFARS; and

(ii) If the Software and fonts are supplied to any unit or agency of the United States Government other
than DoD, the Government’s rights in the Software, its documentation and fonts will be defined in Clause
52.227-19(c)(2) of the FAR, or in the case of NASA, in clause 18-52.227-86(d) of the NASAsupplement to the
FAR.

6. Disclaimer of Warranty on Software. You expressly acknowledge and agree that use of the Software and
fonts is at your sole risk. The Software, related documentation, and fonts are provided “AS IS” and without
warranty of any kind and PelicanWare, Inc. and PelicanWare, Inc.’s Licensor(s), if any, (for the purpose of pro-
visions 6 and 7 shall be collectively referred to as “PelicanWare, Inc.”) EXPRESSLY DISCLAIM ALL WAR-
RANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. PELICAN SOFTWARE, INC.
DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILLMEET YOUR
REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE WILLBE UNINTERRUPTED OR
ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE AND THE FONTS WILLBE CORRECTED. FUR-
THERMORE, PELICAN SOFTWARE, INC. DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS
REGARDING THE USE OF THE RESULTS OF THE USE OF THE SOFTWARE AND FONTS OR RELATED
DOCUMENTATION IN TERMS OF THEIR CORRECTNESS, ACCURACY, RELIABILITY, OR OTHERWISE.
NO ORALOR WRITTEN INFORMATION OR ADVICE GIVEN BY PELICAN SOFTWARE, INC. OR AN
AUTHORIZED REPRESENTATIVE SHALLCREATE A WARRANTY OR IN ANY WAY INCREASE THE
SCOPE OF THIS WARRANTY. SHOULD THE SOFTWARE PROVE DEFECTIVE, YOU (AND NOT PELI-
CAN SOFTWARE, INC. OR APELICAN SOFTWARE, INC. AUTHORIZED REPRESENTATIVE) ASSUME
THE ENTIRE COST OF ALLNECESSARY SERVICING, REPAIR, OR CORRECTION. SOME JURISDIC-
TIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION
MAY NOT APPLY TO YOU.

7. Limitation of Liability. UNDER NO CIRCUMSTANCES INCLUDING NEGLIGENCE SHALLPELICAN
SOFTWARE, INC. BE LIABLE FOR ANY INCIDENTAL, SPECIALOR CONSEQUENTIALDAMAGES
THAT RESULT FROM THE USE OR INABILITY TO USE THE SOFTWARE OR RELATED DOCUMENTA-
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TION, EVEN IF PELICAN SOFTWARE, INC. OR AN AUTHORIZED REPRESENTATIVE HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS DO NOT ALLOW THE
LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTALOR CONSEQUENTIALDAMAGES SO
THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU. In no event shall PelicanWare,
Inc.’s total liability to you for all damages, losses, and causes of action (whether in contract, tort (including
negligence) or otherwise) exceed the amount paid by you for the Software and fonts.

8. Controlling Law and Severability. This License shall be governed and construed in accordance with the
laws of the United States and the State of Oregon, as applied to agreements entered into and to be performed
entirely within Oregon between Oregon residents. If for any reason a court of competent jurisdiction finds
any provision of the License, or portion thereof, to be unenforceable, that provision of the License shall be
enforced to the maximum extent permissible so as to effect the intent of the parties, and the remainder of this
License shall continue in full force and effect.

9. Complete Agreement. This License constitutes the entire agreement between the parties with respect to the
use of the Software, related documentation and fonts, and supersedes all prior or contemporaneous under-
standings or agreements, written or oral, regarding such subject matter. No amendment to or modification of
this License will be binding unless in writing and signed by a duly authorized representative of PelicanWare,
Inc.

NOTE: Some of the images included with the Software are licensed from T/Maker Company, and may be
used only according to the following End User License Agreement:

END USER LICENSE AGREEMENT FOR CLICKART® AND SNAP ART™ IMAGES 
—NOTICE TO USER—

DO NOT USE THE CLIP ART IMAGES UNTILYOU HAVE READ THIS AGREEMENT

T/Maker Company ClickArt and Snap Art License Agreement
©1984-1995 T/Maker Company. All Rights Reserved.

United States copyright law and international copyright treaties protect these ClickArt and Snap Art images
and fonts (“The Images and Fonts”). T/Maker Company (“T/Maker”) depended on the availability of this pro-
tection when it decided to spend the time and money required to produce The Images and Fonts.
Nevertheless, T/Maker realizes that you have licensed this copy of The Images and Fonts so that you could
copy The Images and Fonts in their present or a modified form and incorporate them into another work.
T/Maker therefore gives you permission to copy and modify The Images and Fonts for your own internal use.
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The Images and Fonts may not be distributed as part of any software product or as part of an electronic docu-
ment or collection of documents without written permission from T/Maker. T/Maker, however, gives you per-
mission to incorporate and distribute duplicate or modified Images and Fonts as an incidental part of any
non-electronic product or collection of products which are distributed commercially (i.e., distributed for prof-
it, such as a newsletter); provided the use or distribution of any of The Images and Fonts does not constitute a
substantial portion of the value of the goods distributed commercially. For example, you may not, without
written permission from T/Maker, use an Image as an art image on a T-shirt or poster manufactured for resale.
You may not make any copies of any portion of The Images and Fonts for distribution or resale. Except as
specifically stated above, you may not copy, modify, or distribute The Images and Fonts.

T/Maker Company grants you this license for a single CPU (central processing unit) only. This software may
not be loaded onto a Local Area Network unless a license has been purchased for each CPU on the Network.

Please call or write T/Maker if you wish to obtain a license to distribute duplicate or modified Images and
Fonts other than expressly permitted under this license, or if you have any questions concerning your rights.

LIMITED WARRANTY
THE ABOVE WARRANTY IS THE ONLY WARRANTY OR REPRESENTATION OF ANY KIND WITH
RESPECT TO THE IMAGES AND FONTS MADE BY T/MAKER OR ANYONE ELSE INVOLVED IN THE
CREATION, PRODUCTION, DELIVERY, OR LICENSING OF THE IMAGES AND FONTS. FURTHER-
MORE, ANY IMPLIED WARRANTIES WITH RESPECT TO THE IMAGES AND FONTS OR DISKS,
INCLUDING IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PUR-
POSE, AND NONINFRINGEMENT OF THIRD PARTY RIGHTS, ARE SPECIFICALLY DISCLAIMED.
NEITHER T/MAKER NOR ANYONE ELSE INVOLVED IN THE CREATION, PRODUCTION, DELIVERY,
OR LICENSING OF THE IMAGES AND FONTS MAKES ANY WARRANTY OR REPRESENTATION OF
ANY KIND, EXPRESS OR IMPLIED, WITH RESPECT TO THE IMAGES AND FONTS OR THEIR QUALI-
TY, RELIABILITY, OR PERFORMANCE, OR THEIR MERCHANTABILITY OR FITNESS FOR ANY PARTIC-
ULAR PURPOSES. THE IMAGES AND FONTS ARE LICENSED “AS IS.” YOU ASSUME THE ENTIRE
RISK AS TO THE QUALITY, RELIABILITY, AND PERFORMANCE OF THE IMAGES AND FONTS. IF THE
IMAGES AND FONTS PROVE DEFECTIVE, YOU, AND NOT T/MAKER OR ANYONE ELSE INVOLVED
IN THE CREATION, PRODUCTION, DELIVERY, OR LICENSING OF THE IMAGES AND FONTS, MUST
ASSUME THE ENTIRE COST OF ALLNECESSARY CORRECTIONS.

DISCLAIMER OF DAMAGES
IN NO EVENT WILLT/MAKER OR ANYONE ELSE INVOLVED IN THE CREATION, PRODUCTION,
DELIVERY, OR LICENSING OF THE IMAGES AND FONTS BE LIABLE TO YOU FOR ANY CONSEQUEN-
TIAL, SPECIAL, INCIDENTAL, DIRECT, OR INDIRECT DAMAGES OF ANY KIND ARISING OUT OF
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THE USE OF THE IMAGES AND FONTS OR ANY DEFECT IN THE IMAGES AND FONTS, EVEN IF
T/MAKER OR ANYONE ELSE INVOLVED IN THE CREATION, PRODUCTION, DELIVERY, OR LICENS-
ING OF THE IMAGES AND FONTS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

This notice will be construed, interpreted, and governed by the laws of the state of California as applied to
transactions taking place entirely within California between California residents. Should you have any ques-
tions concerning this Agreement, please contact in writing T/Maker Company, 1390 Villa Street, Mountain
View, CA94041, USA, 415/962-0195, Fax: 415/962-0201.

ClickArt and T/Maker are registered trademarks of T/Maker Company. Snap Art is a trademark of T/Maker
Company.
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IN D E X

Absolute cell reference
Use of $ sign 2 9

Action button 15, 48
A l i g n

Align To o l 1 4
O b j e c t s 1 4
Te x t 1 8 - 1 9

Auto 4 4
Auto Recalculate 28, 30
A u t o - S e l e c t 1 3
Av g L e f t 3 0
B e a m i n g 4 8
Beginning of the selection key 2 1
B r a c k e t s 2 2
B u l l e t s , 2 2
Cancel Button 2 8
Cell entry area 2 6
C e n t e r i n g 8
C l e a r

Cell contents 3 2
O b j e c t s 1 0 - 1 2

Clip text 1 9
C l i p A r t 5 2

B r o w s e r 10, 52
Bundled Libraries 5 3
Copy To 1 0
I n s t a l l e r 5 2
Paste From 1 0
Visual Indicies 5 3

Column width 3 3
C o l u m n s 2 4
C o n n e c t / I m p o r t 5 0
C o n s t r a i n 13, 15

S h a p e s 1 6
C o p y

Cell contents 3 1
C e l l s 3 0
O b j e c t s 1 0
To Notepad 4 7

Curve tool 1 6
C u t

Cell contents 3 1
C o l u m n 3 0
O b j e c t s 9
R o w 3 0

Del key 2 8
D e l e t e 4 8

D o c u m e n t 8
O b j e c t s 8
Table Editor

Cell contents 2 8
C o l u m n 3 0
N u m b e r 2 9
R o w 3 0
Wo r d 2 8

Text Editor
Delete All key 2 1
Wo r d 2 1

D i s c o n n e c t 5 1
Drawing Order 1 4
Drawing tools 1 5

C u r v e 1 6
Default settings 1 6
Fill patterns 1 7
O v a l 1 6
Pen patterns 1 7
Pen width 1 7
P o l y g o n 1 6
R e c t a n g l e 1 6
Rounded rectangle 1 6
S h a p e s 1 6
Straight line 1 5
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S p r e a d s h e e t
A l i g n m e n t 3 3
C o l u m n 3 0
Column width 3 3
F o n t 2 6
Font size 2 6
F r a m e 2 5
G r i d l i n e s 2 5
N u m b e r 3 3
R o w 3 0
S t y l e 3 3
Table title 2 4

Text box 1 8
F r a m e

G r a p h 4 0
S p r e a d s h e e t 2 5
Text box 1 9

Front Selections Only 1 3
Function keypad 27, 29
F u n c t i o n s

Changes when deleting 3 0
Changes when inserting 3 0
On-line help 2 9

Go To Cell key 26, 29
G r a p h

Auto Unlink 3 6
C r e a t i n g 3 9
E x p o r t 4 7
F o n t 4 0
Font size 4 0
F r a m e 4 0
G r i d l i n e s 3 9
L i n k e d 3 3
Ti t l e 3 9
Va l u e s 4 4

Graph Editor 4 0
A u t o 4 4

D u p l i c a t e 4 8
End of selection key 2 1
E n t e r 27, 29
Error message 3 0

P r i n t i n g 4 8
Error sound 3 0
E x p o r t

Charts & Graphs 4 7
S p r e a d s h e e t 30, 47, 51
Terminal program settings 4 9
Te x t 24, 30, 47, 51

F a x i n g 4 8
Tr o u b l e s h o o t i n g 4 8

F i l i n g
Naming pages 4 6

Filing Button 1 5
F i l l

Columns & rows 3 2
Fill patterns 7, 17
F o l d e r

F i l e 4 6
N e w 4 6
R e n a m e 4 6

Folder tab 4 7
F o n t

G r a p h
Font change 4 0
S i z e 4 0

S p r e a d s h e e t
Font change 2 6
S i z e 2 6
S t y l e 3 3

Text box
Font change 1 8
S i z e 1 8
S t y l e 1 9

F o r m a t
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N e w 2 3
R e n a m e 2 3
S a v i n g 2 3

M a i l
P a g e 4 8
Tr o u b l e s h o o t i n g 4 8

Math symbols 2 2
Mode selector 7, 24
Money symbols 2 2
Move Backward 1 4
Move Forward 1 4
Move to Front 1 4
Moving Objects 7
New page 9
Nudge tool 1 4
N u m b e r s

Graph series values 4 2
Graph values 4 4
S p r e a d s h e e t 2 9
Text Editor 2 2

Numeric keypad 27, 29
O b j e c t s

A l i g n 1 4
A u t o - S e l e c t 1 3
C l e a r 1 0 - 1 2
C o p y 1 0
C u t 9
D e l e t e 8
Drawing order 1 4
Move backward 1 4
Move forward 1 4
Move to front 1 4
N u d g e 1 4
P a s t e 1 0
R e s i z i n g 8
Select A l l 1 2
Select None 1 2

Data entry area 4 2
L a b e l s 4 2
L e g e n d

Bar and line graphs 4 4
Pie charts 4 5

Linked Ta b l e s 3 8
Patterns, pie charts 4 2
Pie chart options 4 4
Pie charts 4 2
Series name 4 2
Series type 4 2
Series values 4 2
S t a c k e d 4 3
Ti t l e 4 2

G r i d l i n e s
G r a p h 3 9
S p r e a d s h e e t 2 5

I m p o r t
C o n n e c t 5 0
From computer 5 0
S p r e a d s h e e t 30, 50
Terminal program settings 4 9
Te x t 24, 50

I n s e r t
C o l u m n 3 0
R o w 3 0

Installation 3
I n s t a l l e r

C l i p A r t 5 2
Keep To o l 1 3
K e y p a d

Table Editor 2 6
Text Editor 20, 22

L i n e s 1 6
Linked graph 3 4
M a c r o s 20-21, 23

I n s e r t i n g 2 3

AvailWorks Manl  8/6/96 4:07 PM  Page 63



64 Index

Rear Selections Only 1 3
Rectangle tool 1 6
R e g i s t r a t i o n 4
Resizing Objects 8

Maintaining proportions 1 3
Rounded Rectangle tool 1 6
R o w s 2 4
Scroll bars 8
Scroll keys 26-27, 29
Select A l l 1 2
Select None 1 2
Selecting Objects 7
Send to Back. 1 4
Shapes tool 1 6
S p r e a d s h e e t

Column width 3 3
C r e a t i n g 2 4
Entering data 2 7
Fill pattern 3 3
F o n t 2 6
F o r m a t t i n g 3 2
F r a m e 2 5
G r i d l i n e s 2 5
Linked Graphs 3 4
Maximum size 2 4
Pen pattern 3 3
Pen width 3 3
R e c a l c u l a t e 2 8
Ti t l e 2 4

Spreadsheet display area 2 6 - 2 7
S p r e a d s h e e t

“ F u n c R e f . t x t ” 2 4
Status area 7
Straight line tool 13, 15
S u m A b o v e 3 0
Ta b 1 9

Text Editor 2 2

Select, front only 1 3
Select, rear only 1 3
Send to back 1 4

On-line Help
E x p o r t 4 7
F u n c t i o n s 2 9
I m p o r t / E x p o r t 5 0

Oval tool 1 6
P a g e 5

B e a m 4 8
D e l e t e 4 7 - 4 8
D u p l i c a t e 4 8
F a x 4 8
M a i l 4 8
N a m e 4 6
New page 9, 47
P r e v i e w 6, 48
R e n a m e 4 7
Vi e w i n g 4 7

P a s t e
Cell contents 3 1
C e l l s 3 0
O b j e c t s 1 0

P a t t e r n s 1 6
Pie charts 4 2

P e n
P a t t e r n 7

Drawing tools 1 7
S p r e a d s h e e t 3 3

Wi d t h 7, 17
S p r e a d s h e e t 3 3

Polygon tool 1 6
Preview page 6
P r i n t

P r e v i e w 4 8
Tr o u b l e s h o o t i n g 4 8

P u n c t u a t i o n 2 2
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K e y p a d 20, 22
Left arrow 2 2
M a c r o s 20, 23
Math symbols 2 2
Money symbols 2 2
Move a word 2 1
N u m b e r s 2 2
P u n c t u a t i o n 2 2
Right arrow 2 1
Space before each word 2 1
Tab key 2 2
Text entry and display area 2 1

Text Layer 17
Tool Bar 7
U n d o 8, 10, 21, 28
Vi e w

Actual Size 6
Fit To Screen 6

Wr a p 1 9

Table Editor 2 6
Cancel button 2 8
Delete character 2 9
Delete key 2 8
Delete word 2 8 - 2 9
Edit words 2 8
Enter key 2 9
F o r m a t t i n g 30, 32
Move words 2 8
S c r o l l i n g 2 9

Table title 24, 26
Technical Support 2
Terminal program 4 9
Text Label Box

A l i g n m e n t 1 8
Alignment of text within 1 9
Clipped text 1 9
C r e a t i n g 1 8
Editing text 2 0
F o n t 1 8
F r a m e 1 8 - 1 9
Multiple styles 1 9
S i z e 1 8
s p a c i n g 1 9
Tab settings 1 8 - 1 9
Text styles 1 8
Wrapped text 1 9

Text Label Editor
Beginning of selection key 2 1
B r a c k e t s 2 2
B u l l e t s 2 2
Carriage return key 2 2
Delete text 2 1
Edit a word 2 1
End of selection key 2 1
Insert or replace words 2 0 - 2 1
Insertion point key 2 2
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